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1 ATIPXpress PAL Deployment Infroduction

The purpose of this document is to provide instructions for creating the ATIPXpress Public
Access Link (PAL) database and installing the ATIPXpress PAL application.

ATIPXpress PAL facilitates the submission of Freedom of Information Act (ATIP) requests over
the internet and allows information to be published to the Electronic Reading Room.
ATIPXpress PAL supports SQL Databases.

(') Notes:

» Thisdocument does not provide instructions for installing windows server or Microsoft
.net. Please consult your software vendor for further details concerning these
installations.

= Asingle server can be used to install ATIPXpress PAL and all its components, however it
is highly recommended to configure separate servers for the ATIPXpress application,
database, and repository due to the processing demands of the CPU.

1.1 Standard ATIPXpress and PAL Deployment
Architecture

The PAL application URL will be accessible by the public for submitting ATIP requests to your
agency. However, the web server and database server must remain secure. The standard
deployment includes the following configuration:

= The PAL Database, PAL Application, and PAL File Server are installed in the External
network (DMZ).

= The ATIPXpress Application, ATIPXpress Database, and all applicable services are installed
in the local intranet.

= The Database Port and HTTPS port are enabled to allow the PAL modules to communicate
with ATIPXpress.

The figure below shows the standard AX PAL deployment architecture:
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2 PAL Installation Prerequisites

2.1 ATIPXpress PAL Deployment System
Requirements

Before proceeding with the installation, it is necessary to do the following:

= |nstall Microsoft SQL Server 2017/2019 on the database server.

=  Configure the SMTP Server to relay email to the email server while using ATIPXpress PAL.
The SMTP server must be configured to relay e-mail messages to other domains.

= Before installing the ATIPXpress PAL database, make sure SQL Server collation is
configured for case-insensitive.

The installation package must be deployed from the application server, which must meet the

requirements outlined below:

Location Deployment scripts can be executed from Application server. The script
must be executed from application server if the Application or Scheduler

are installed.
User The logged-in user should have the local administrator permissions.
Permissions
Operating Windows 2016/2019/2022
System
Requirements
URL Rewrite Install the Microsoft IIS URL Rewrite extension, available via

https://www.iis.net/downloads/microsoft/url-rewrite



https://www.iis.net/downloads/microsoft/url-rewrite
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Microsoft .NET Microsoft .NET Framework 4.8 Runtime must be downloaded and

Framework 4.8 installed. It can be downloaded and installed from the following location:

Runtime https://dotnet.microsoft.com/en-us/download/dotnet-
framework/net48

SqlPackage The SqlPackage must be downloaded and installed. It can be

downloaded and installed from the following location:

https://learn.microsoft.com/en-us/sql/tools/sqlpackage/sqlpackage-

download?view=sql-server-verl1l6#windows-net-framework

SqlServer The SqlServer module must be downloaded and installed on the
application server. See the Install SQL Server Module section for steps.

PowerShell PowerShell 5.1.22621.963 must be installed for deployment using auto
Version deployment.

https://www.microsoft.com/en-us/download/details.aspx?id=54616

2.2 ATIPXpress PAL Database Account Requirements

There are three accounts which must provisioned to configure the application, database, and
repository servers. The table below outlines the type of accounts, their purpose, and their
requirements.


https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48
https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48
https://learn.microsoft.com/en-us/sql/tools/sqlpackage/sqlpackage-download?view=sql-server-ver16#windows-net-framework
https://learn.microsoft.com/en-us/sql/tools/sqlpackage/sqlpackage-download?view=sql-server-ver16#windows-net-framework

Application
Setup

ATIPXpress PAL
Database
Creation

ATIPXpress PAL
Database User
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This user installs and
configures the
ATIPXpress PAL
application and its
components.

This user setsup the PAL
database user account
and grants any required
permissions.

This user performs all
ATIPXpress PAL database
transactions required for
the ATIPXpress PAL
Application.

This account is set up as a Domain/Local
User and is a member of the
Administrators on server groups.

This account is added to the following
SQL Server security roles for the user
that will create the database either in SQL
Server (Windows User) or Windows
Authentication Mode (NT User):

e dbcreator
e securityadmin

This account must be assigned as a
member of the db_owner database role
for the ATIPXpressPAL SQL Server
database.

2.3 Install SOL Server Module

Follow the steps below to install the SQL Server Module on the application server:

1. Navigate to the following link:
https://www.powershellgallery.com/packages/Sqlserver/21.1.18256

2. Under Installation Options, select Manual Download:


https://www.powershellgallery.com/packages/Sqlserver/21.1.18256

PAL Installation Prerequisites

v Installation Options

Install Module Azure Automation Manual Download

Manually download the .nupkg file to your system's default download location. Note that the file won't
be unpacked, and won't include any dependencies. Learn More

Download the raw nupkg file

Click Download the raw nupk file. The SQLserver .nupkg file downloads.

Locate the downloaded "SQLserver” file, then right click it and select Properties.
On the General tab, select Unblock, then click Apply.

Next, edit the “SQLserver” file extension from .nupkg to .zip.

N o Uk W

Extract the .zip package in the downloaded location. After the folder is extracted, remove
“sqlserver.” from the folder name:

Jo|ELLVERY 1.1.18256

8. Navigate to C:\ProgramFiles\WindowsPowerShell\Modules and create a folder called
SqlServer.

9. Copy the renamed .zip folder from the downloaded location to the SqlServer folder created
in the previous step (C:\ProgramFiles\WindowsPowerShell\Modules\SqlServer)

2.4 Enabling Windows Search Service

Windows Search Service allows users to perform search operations on the server. This service
is required to perform content searches on documents located in the PAL Reading Room.

(') Notes:

= Administrators are not be able to install windows search services if the indexing service is
installed on the server. They must uninstall the indexing service then install the windows
search service.

= Thisservice must be enabled on the application server.

Follow the steps below to enable Windows Search Service:

1. Click Start > Server Manager. The Server Manager application appears.

gj 10
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Server Manager * Dashboard V' Monsge oo
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2. Click Add roles and features. The Add Roles and Features Wizard pop up window appears.

= Add Roles and Features Wizard = | =] 2=

DESTINATION SERVER

BefO re YOU beg Iﬂ TW-Sandbozx.zins-inccom

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
haosting a website.

Server Selection

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Metwork settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, dick Next.

[] Skip this page by default

< Previous Install

3. Click Next. The Select installation type window appears.
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. 2 DESTINATION SERVER
Select installation type TW-Sandbotains e com
Before You Begin Select the installation type. You can install roles and features on a running physical computer or virtual

machine, or on an offline virtual hard disk (VHD).

@ Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation

Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

< Previous | | Next > Install Cancel

4. Select Role-based or Feature-based installation using the radio buttons.
5. Click Next. The Select Destination Server pop up window appears.

Select destination server e

TW-Sandboxains-inccom

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installation Type

(® Selact a server from the server pool
) Select a virtual hard disk

Server Pool

Filter:

Name IP Address Operating System

TW-Sandbox.ains-inc.com  192.168.0.85 Microsoft Windows Server 2012 R2 Standard

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

< Previous | | Next > Install Cancel

6. Select aserver or a virtual hard disk using the radio buttons.
7. Click Next. The Select server roles pop up window appears.

gj 12
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DESTINATION SERVER
Select server roles TW.Sandooains-inccom
Before You Begin Select one or more roles to install on the selected server,
Installation Type Roles Description
Server Selection ~ Active Directory Certificate Services
e — {AD CS) is used to create
[ Active Directory Domain Services certification authorities and related
Features [ Active Directory Federation Services role services that allow you to issue
[] Active Directory Lightweight Directory Services anc_l manage ct_zrtlﬁcates CE= e
variety of applications.
[] Active Directory Rights Management Services
[ Application Server =
[] DHCP Server
[] DNS Server
[] Fax Server
> [® File and Storage Services (2 of 12 installed)
[ Hyper-V
[[] Metwork Pelicy and Access Services B
[] Print and Document Services
[] Remote Access
[[] Remote Desktop Services ]
w
< Previous | | MNext » | | Install | ‘ Cancel

8. Click Features from the left-hand menu, then select Windows Search Service.
9. Click Next. The Confirm installation selections pop up window appears.

DESTINATION SERVER

Confirm installation selections T -

Before You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type ] d

Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, dlick Previous to clear

Server Roles their check boxes.

Features

Windows Search Service

Export configuration settings
Specify an alternate source path

<previous | | Nea> | [ msal | [ cancel

10. Click Install to start the installation process. The Installation progress pop up window
appears:

2

13



PAL Installation Prerequisites

DESTIMATION SERVER

Installation progress TW-Sandboains inc com

View installation progress

o Feature installation
L
Installation started on TW-Sandbox.ains-inc.com

Windows Search Service

You can close this wizard without interrupting running tasks. View task progress or open this

page again by clicking Motifications in the command bar, and then Task Details.

Export configuration settings

< Previous | | Next = | | Close | | Cancel

11. Theinstallation process begins. This may take a few moments. After the installation
completes a confirmation window appears.

DESTINATION SERVER

Installation progress TW-Sandboains.inc com

View installation progress

o Feature installation
|
Installation succeeded on TW-Sandbox.ains-inc.com.

Windows Search Service

You can close this wizard without interrupting running tasks. View task progress or open this

page again by clicking Motifications in the command bar, and then Task Details.

Export configuration settings

< Previous | | Next > | | Close | | Cancel

12. Click Close to exit the Add Roles Wizard.

gj 14
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2.5 Enable TIFF files in Windows Search Service

TIFF is a file format for storing images. TIFF files are not enabled for search by default;
therefore, you must enable the Windows TIFF IFilter feature in order to search TIFF files.

1. Click Start > Server Manager. The Server Manager application launches, as shown below.

v @1V Maage Toos

Server Manager * Dashboard

ﬂ Configure this local server
QUICK START

B Local Server

& Al servers

= 2 Add roles and features
2 File and Storage Services > E) Add roles and featur
o us 3 Add other servers to manage

WHAT'S NEW.

4 Create a server group

5 Connect this server to cloud services
Hide

LEARN MORE

ROLES AND SERVER GROUPS
Rolesi2 | Servergroups: 1 | Servers total 1

P ;!fv?::ssm'age 1 Iis 1 § Local server §5 All servers 1
@ Manageability @ Manageability @ Manageability @ Manageability

Events Events Events Events

Services Services Services Services

Performance Performance Performance Performance

BPA resits BPA results BPA results BPA resuits

7 AERERARCEEA

e [&] «]

2. Click Add roles and features. The Add Roles and Features Wizard pop up window appears.

=] Add Roles and Features Wizard =N EE

DESTINATION SERVER
TW-Sandboz.ains-inc.com

Before you begin

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
hasting a website,

Before You Begin

Installation Type

Server Selection )
To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static IP addresses, are configured
* The most current securty updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[] Skip this page by default

3. Click Next.

2
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DESTINATION SERVER

Select installation type TW-Sandbotains e com

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

Befcre You Begin

(®) Role-based or feature-based installation

Server Selection
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

< Previous | | Next > Install -

4. Select Role-based or feature-based installation.
5. Click Next.

DESTINATION SERVER

Select destination server TW-Sandbonains-ine com

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

) Select a server from the server pool

Installation T
Sarver Salaction () Select a virtual hard disk
Server Roles Server Pool
Features
Filter: |
Name IP Address Operating System

TW-Sandbox.ains-inc.com  192.168.0.85 Microsoft Windows Server 2012 R2 Standard

1 Computer(s) found
This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data

collection is still incomplete are not shown.

< Previous | | Next > Install -

6. Select from the available options.
7. Click Next.

2
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DESTINATION SERVER

Select server roles TW-Sandboxains-inc com

Select one or more roles to install on the selected server,

Befcre You Begin

Installation Type Roles Description
Server Selection Active Directory Certificate Services
(AD C5) is used to create
[ Active Directory Domain Services certification authorities and related
Features [[] Active Directory Federation Services rale services that allow you to issue
[] Active Directory Lightweight Directory Services anc_l manage ct_zrtlﬁcates CE= e
variety of applications.
[] Active Directory Rights Management Services
[ Application Server =
[] DHCP Server
[] DNS Server
[] Fax Server
> [® File and Storage Services (2 of 12 installed)
[ Hyper-V
[[] Metwork Pelicy and Access Services B
[] Print and Document Services
[] Remote Access
[[] Remote Desktop Services ™
< Previous | | MNext » | | Install | ‘ Cancel

8. Select Features.
9. Select Windows TIFF IFilter.
10. Click Next.

DESTINATION SERVER

Confirm installation selections TW-Sendbocains-inc com

Before You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type [[] Restart the destination server automatically if required

Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear

Server Roles their check boxes.

Features

Windows TIFF IFilter

Export configuration settings
Specify an alternate source path

<Previous | | Net> | [ sl |[ Cancel

11. Click Install.

gj 17



PAL Installation Prerequisites

DESTINATION SERVER

Installation progress TW-Sandboxains inc com

View installation progress

o Feature installation

Installation started on TW-5Sandbox.ains-inc.com

Windows TIFF IFilter

You can close this wizard without interrupting running tasks. View task progress or open this

page again by clicking Netifications in the command bar, and then Task Details.

Export configuration settings

<Prewous|| Mext > | | Close || Cancel

12. The installation process continues. This may take a few minutes
installation confirmation appears:

DESTINATION SERVER

Installation progress TW-Sandboxains-inccom

View installation progress

o Feature installation
L]

Installation succeeded on TW-Sandbox.ains-inc.com.

Windows TIFF IFilter

You can close this wizard without interrupting running tasks. View task progress or open this

page again by clicking Motifications in the command bar, and then Task Details.

Export configuration settings

< Previous | | MNext > | | Close | | Cancel

13. Click Close to exit the Add Roles Wizard.

.On conclusion, an
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2.6 Enable PDF in Windows Search Service

PDF files are not enabled for search by default; you must install the Adobe PDF IFilter feature
to search PDF files. Follow the steps below to enable PDF in Windows Search Service.

1. Download and install Adobe PDF IFilter 9 from the following link:
ftp://ftp.adobe.com/pub/adobe/acrobat/win/9.x/.

2. Restart the Windows Search Service after installing Adobe PDF IFilter 9/11:
a. Click Start > Administrative Tools > Services. The Services application launches.

b. Scrolldown and select Windows Search.

) Services == -
File Action View Help
e mEGE Hm »unn
£, Services (Local) “. Services (Local)

Windows Search Mame - Description Status Startup Type Log ~
£ Windows Encryption Provid... Windows E... Manual (Trig.. Loc

Stop the service % Windows Error Reporting Se.. Allows error... Manual (Trig.. Loc

Restart the service £ Windows Event Collector This service ... Manual Met
“: Windows Event Log This service... Running  Automatic Loc

Description: & Windows Firewall Windows Fi... Running  Automatic Loc

Provides content indexing, property %o Windows Font Cache Service  Optimizes p..  Running  Autematic Loc

caching, and search results for files, e- £ Windows Installer Adds, modi.. Manual Loc

mail, and other content. ‘
5 Windows Management Inst.. Providesa .. Running  Autematic Loc
L5 Windows Modules Installer  Enables inst.., Manual Loc
. Windows Presentation Fou...  Optimizes p... Manual Loc
L4 Windows Process Activatio.. TheWindo...  Running  Manual Loc
%i Windows Remote Manage...  WindowsR..  Running  Autematic Met
# Windows Search Provides co.. Running  Automatic (D...
5 Windows Store Service (WS...  Provides inf... Manual (Trig.. Loc
% Windows Time Maintains d... Running  Manual (Trig... Loc
L Windows Update Enablesthe.. Running Manual (Trig.. Leoc
S5 WinHTTP Web Proxy Auto-.. WinHTTP Q..  Running  Manual Loc
£ Wired AutoConfig The Wired ... Manual Loc
5 WMI Performance Adapter  Provides pe... Manual Loc =
54 Workstation Creates and... Running  Autematic et
% World Wide Web Publishin... Provides W.. Running  Automatic Loc .
< m >

\ Extended /(Standard/

3. Click Action > Restart. The Service Control pop up window appears.

Service Contral -

Windows is attempting to start the following service on Local Computer...

Windows Search

4. Select File > Exit to close the Services application.

2
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5. Click Start > Control Panel > Indexing Options. The Indexing Options pop up window
appears.

42 Indexing Optians x
864 items indexed
Indexing complete.

e

TIndex these locations:

Included Locations Excluce
Start Menu
Users AppData; AppData; AppData
"
4
Modify #y Advanced = Pause
Howi does indexing affect searches?

Troubleshoot search and indexing

Close

6. Click Modify to add the Reading Room root folder.

7. Addthe electronic reading room root path to the included locations (e.g.
C:\PALRepo\AFXWERR\):

s Indexed Locations X

Change selected locations
[]~ . Local Disk (C:) A
I azagent
backup
inetpub
Opexus
PALBuild
v PALRepo
AFXWDOCS
AFXWERR
PerfLogs
Program Files
Program Files (x86)
PS
Temp v

OoooorOoOoooOog

Summary of selected locations
Included Locations Exclude
AFXWERR
Start Menu
Users AppData; AppData; AppData

-'Show all locations Cancel

8. Click Advanced. The Advanced Options pop up window appears.
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910 items indexed v & Search Contral F

Advanced Options %

2 Indexing In progress. Sear
Index Settings  File Types fall

File Settings
Index these locations:
["]Index encrypted flles
Included Locations [T]Treat similar words with diacritics as different words
AFKWERR
Start Menu
Users Troubleshooting
Delete and rebuild index Rebuild

Troubleshoot search and indexing

Index location
Current location:
C:\ProgramData\Microsoft

New location, after service is restarted:

p— Select new
Modify o Advanced

How does Indexing affect searches?

Advanced indexing help
Troubleshoot search and indexing

9. Click the Rebuild button located in the Troubleshooting section. The Rebuild Index pop up
window appears.

Rebuild Index -

Rebuilding the index might take a long time to complete. Some views
and search results might be incomplete until rebuilding is finished.

QK | | Cancel

10. Click OK. The Indexing Options window changes to display the rebuild progress. This may
take several minutes to complete. Once the rebuild is completed, the Indexing Options
window will indicate the total number of items rebuilt.

21



PAL Installation Prerequisites

139 items indexed

Index these locations:

& Indexing speed is reduced due to user activity.

Induded Locations Exdude

@Inhernet Explorer History (TW-SANDBOX. ..

| 5tart Menu

i Users AppData; AppData
wodty | [ Biduanced | [ Geawe |

How does indexing affect searches?

Troubleshoot search and indexin

11. Click Close to exit the Indexing Options feature.

12. Close the Control Panel window.
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3 Download the Installation Package

The FOIAXpress installation package contains the files needed to install ATIPXpress PAL.
Contact OPEXUS support at support@opexustech.com for your installation package.

After downloading the package, follow the steps below to unzip the file:

1. Locate thedownloaded .zip file, thenright click it and select Properties.
2. On the General tab, select Unblock, then click Apply.

3. Next, unzip the contents of the folder. The contents of the package appear as shown in the
following example:

Py

(] Mame Type Date modified
dbscripts File folder 2/24/2023 &
FOlAXpress File folder 2/247202
installscripts File folder 2/247202

| | inputs.json J50M File 22472023 8:2
|y install Windows PowerShell Script 2/2472023 8:2
|8 uninstall Windows PowerShell Script 2/24/2023 &

3.1 Verify the Integrity of the Installation Package

Steps to verify the integrity of the installation package.

1. Open Windows Powershell ISE.

2. Use the command below to verify the integrity of installation package:
Test-FileCatalog -CatalogFilePath "<<catalog file path(with extension of .cat) from downloaded
artifact>>"-Path "<< folder that should be validated against the catalog file >>"

3. ltwill show as valid, as shown in the following example:

windzwes dowershel 5k - =

3.2 About the Installation Package

There are two primary files you'll interact with during installation:
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PAL Installation Prerequisites

[] Mame
dbscripts
FOlAXpress

installscripts

|| inputs.json o
| &y install e

| & uninstall

Inputs.json: Drives the installation of the FOIAXpress system components. The file isin a
standard json format and needs to remain a valid json file for successful installation.

Install.ps1: The executable file you will run to deploy the installation package with the
parameters configured in the Inputs.json file.
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4 Inputs.Json Settings for New Installations
4.1 About the Inputs.json File

The Inputs.json file located in the root directory of the extracted deployment package zip file
drives the installation of the different components of the ATIPXpress PAL system. Thefile is in
astandard json format and needs to remain a valid json file post updates prior to the
installation.

The settings are grouped into sections, each addressing settings which may or may not require
configuration, depending on your specific installation. The following subsections in this chapter
describe each section of the Inputs.json file.

The parent node is the ‘inputs’ section. This section appears as follows:

{
"inputs": {

"InstallType™: {
"New": "N",
"Upgrade": "Y"

¥s

"Components™: {
"APPT™: Y™,
"DB": "N"

b

Each section has parameters you can adjust to configure your installation. An example section
is shown below, with an explanation for how it works:

Each (1) Section (“InstallType” in this example) includes various (2) Settings (“New” in this
example) to configure.

{
"inputs": {
"InstallType":
"New": "N",
"Upgrade™: “Y"

I A E]
"L"nmn#nfq”:

For each (A) Setting (“Upgrade” here), you can edit the (B) text in quotations (“N” here to
indicate “No”) to configure the settings for your installation. This might include adding a file
path, user name, password, or simply a “Y” or “N” depending on the field you are configuring.
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The first section under the parent node is the Install Type. See the following section for details
on configuring your install type, with the remaining sections following in the order they appear
in the Inputs file.

4.2 Install Type

Use the “InstallType” section to determine if this is a new installation, or an upgrade for an
existing system:

"InstallType™: {
"New": "N",
FTUPEFEdEFr: !r'\lr!r

New Determine whether this is a new installation. For new installations this

should be a “Y” value.

Upgrade Determine whether this is an upgrade for an existing application. For new
installations this should be a “N” value.

4.3 Install Components

The “Components” section allows you to determine which components to include with this
installation. To include a component with your installation, be sure to assign the component a
“Y” value on the corresponding line.

¥

"Components”: {
"APP": Y,
"DB": "N"
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APP Include the ATIPXpress PAL Application in this installation procedure.
This should be a “Y” value for new installations.

DB Include the ATIPXpress PAL Database in this installation procedure. This
should be a “Y” value for new installations.

4.4 Application and Scheduler

The “APPANDSCHEDULER” section has settings related to the ATIPXpress PAL application
and scheduler installations. A value must be set for all values in this section to successfully
install the application:

('') Note: any files paths specified must have two backslashes where a path in windows
explorer requires a single backslash.

"APPT: {
"Installlocation”: "C:%Y\Program Files",
"Backuplocation™: "C:3\\Backup",
"55LCert”: {
"CertPath”: "«<«CERTIFICATE PATH»»",
"CertPassword”: "<<CERTIFICATE PASSWORD>»"
s
"PALSSLCert": {
"SSLPort": "«<«<PAL SSL PORT»>»",
"DnsMame"™: "PAL"
s
"PALConfigsSlCert™: {
"SSLPort": "«<«<PAL CONFIG SSL PORT»»",
"DnsMame"”: "PALConfig"

s
"AppPool”: "PALAppPool”

InstallLocation Specify a path for the application installation. Note this must be a file
path for the .json file the execute.
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BackupLocation Specify a path for the application backup location. Note this must be
afile path for the .json file the execute

SSLCert The following lines contain the SSL Certificate information. No data
is required on this line. This is the grouping for SSL Certification
settings to be used for the installation.

CertPath Specify a path where the .pfx certificate file is located. Note this
must a file path for the .json file to execute

CertPassword Enter the password associated with the certificate linked in the
“CertPath” field

PALSSLCert The following lines contain the PAL SSL Certificate information

SSLPort The network port designated for PAL’s secure communications using
SSL

DnsName DNS name associated with the PAL application

PALConfigSSLCert The following lines contain the PAL Configuration SSL Certificate
information

SSLPort The network port designated for PAL Configuration to communicate
securely using SSL

DnsName DNS name associated with PAL Configuration

AppPool Enter the name of the application pool associated with your
ATIPXpress application,
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4.5 Database Settings

The “DB” section contains the settings for installing or upgrading your ATIPXpress PAL
database. In case of a new installation, an agent account will be created.

"DB": {

"DBServer”: "PROJ-FX-50QL81",

"DBMame": "FXPALDBE_ASHOK 8216231,
"CreaterDBUserId”: "sa",
"CreaterDBUserPassword”: "Ains$48e",

"IntegratedSecurity”:

e

»

"Agenthccount”™: "<<AGENT NAME TO CONMECT PAL DB»>",
"AgentAccountPassword™: "<<AGENT PWD>»>",
"AgentAccountIntegratedSecurity™: "N"

DBServer

DBName

CreaterDBUserID

CreaterDBUserPassword

IntegratedSecurity

Name assigned to the server responsible for storing,
retrieving, and managing ATIPXpress data

Name given to the specific database used for
ATIPXpress

Database User ID to be used for this installation. The
CreaterDBUserld should have admin rights with the
ability to create a new database or database object on
the specified Database server

Password associated with the account used in the
“CreaterDBUserID” field

The Integrated Security property instructs the SQL
Client to connect to SQL Server using Windows
Authentication through the Security Support Provider
Interface (SSPI). Use “Y” or “N” to determine if you are
using Integrated Security in this installation.
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AgentAccount The SQL server login account to be created in case of a
new database install or the login already setup for the
database being upgraded

AgentAccountPassword The SQL server Agent Account password specified in
the AgentAcount setting

AgentAccountintegratedSecurity Whether integrated security should be used when
connecting to the database, default is “N”

4.6 Configuration Settings

Settings to configure the PAL Administration user details as well as the basic Organization
details.

"Configuration™: {

"AdminUser": {
"FirstMName": "Admin",
"LastName": "Admin™,
"Email": "<<EMAIL ID»>»",
"Login": "Administrator",
"Password”: "<<PASSWORD>»"

s

"Organization™: {
“"Name": "<<ORGANIZATION MAME»",
"Email": "<<ORG EMAIL ID»>"

AdminUser Fields to configure the PAL Administration admin user details
FirstName First name for the PAL Admin user
LastName Last name for the PAL Admin user
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Email

Login

Password

Organization

Name

Email

Email ID associated with the PAL Admin user

Login ID for the PAL Admin user

Password associated with the Login ID provided above

Details about the organization as configured for PAL

Organization name

Email ID associated with the organization
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5 Inputs.json Settings for PAL Upgrade

This section discusses the inputs.json settings used when upgrading an existing AX PAL
environment. For information on using the inputs.json file, see the About the Inputs.json File
section of this manual.

('') Note: Some fields that would be required for a new installation should be left as-is for an
upgrade. It is important to not edit or remove these fields as this could compromise the
integrity of the inputs.json file. These are described where appropriate in the following
sections.

5.1 Install Type

Use the “InstallType” section to determine if this is a new installation, or an upgrade for an
existing system:
"InstallType": {
FPNEWFP: erlrl
"Upgrade”: "Y"

New Determine whether this is a new installation. For upgrades this should be a “N”
value.

Upgrade Determine whether this is an upgrade for an existing application. For upgrades
this should be a “Y” value.

5.2 Install Components

The “Components” section allows you to determine which components to include with this
upgrade. To include a component with your upgrade, be sure to assign the componenta “Y”
value on the corresponding line:
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T

"Components”: {
“APPY: YWY,
"DE": "NT

-

APP Include the ATIPXpress PAL Application in this upgrade procedure.

DB Include the ATIPXpress PAL Database in this upgrade procedure.

5.3 Application and Scheduler

The “APPANDSCHEDULER” section only requires input in the InstallLocation and
BackupLocation fields.

(') Note: All fields not listed above can remain as-is during an upgrade.

"APPT: {
"Installlocation”: "C:%Y\Program Files",
"Backuplocation™: "C:3\\Backup",
"55LCert”: {
"CertPath”: "«<«CERTIFICATE PATH»»",
"CertPassword”: "<<CERTIFICATE PASSWORD>»"
s
"PALSSLCert": {
"SSLPort": "«<«<PAL SSL PORT»>»",
"DnsMame"™: "PAL"
s
"PALConfigsSlCert™: {
"SSLPort": "«<«<PAL CONFIG SSL PORT»»",
"DnsMame"”: "PALConfig"

s
"AppPool”: "PALAppPool”
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Inputs.json Settings for PAL Upgrade

InstallLocation Specify a path for the application installation. Note this must be a file
path for the .json file the execute.

BackupLocation Specify a path for the application backup location. Note this must be
afile path for the .json file the execute

5.4 Database Settings

The “DB” section contains the settings for installing or upgrading your ATIPXpress database. In
case of a new installation, an agent account will be created.

(') Note: You do not need to edit the AgentAccount fields during an upgrade, these can
remain as-is.

"DB": {
"DBServer”: "PROJ-FX-SQL@1",
"DBName": "FXPALDB ASHOK 8216231",
"CreaterDBUserId": "sa",
"CreaterDBUserPassword”: "Ains$4pea",
"IntegratedSecurity™: "N",
"AgentAccount™: "<<AGENT MAME TO CONMECT PAL DB»»",
"AgentAccountPassword™: "<<AGENT PWD>»",
"AgentAccountIntegratedSecurity™: "N"

DBServer Name assigned to the server responsible for storing,
retrieving, and managing ATIPXpress data

DBName Name given to the specific database used for ATIPXpress



Inputs.json Settings for PAL Upgrade

CreaterDBUserID Database User ID to be used for this installation. The
CreaterDBUserld should have admin rights with the ability
to create a new database or database object on the specified
Database server

CreaterDBUserPassword Password associated with the account used in the
“CreaterDBUserID” field

IntegratedSecurity The Integrated Security property instructs the SQL Client to
connect to SQL Server using Windows Authentication
through the Security Support Provider Interface (SSPI). Use
“Y”or “N” to determine if you are using Integrated Security
in this installation.

5.5 Configuration Settings

Settings to configure the PAL Administration user details as well as the basic Organization
details.

('') Note: These fields can remain as-is during the upgrade.
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B Install PAL

Before you are ready to run the Install.ps1 file, review the steps below to verify you've
completed all the steps to this point:

= Make sure you have connectivity to the servers where the software is being installed.
= Complete the procedures described in the PAL Installation Prerequisites section.

= Download, verify, and extract the ATIPXpress PAL Installation package.

= Configure the Inputs.json file for your installation.

Once the above prerequisites are complete, follow the steps below to deploy the ATIPXpress
PAL Installation package.

1. Open Windows Powershell ISE.
2. Use PowerShell to navigate to the location where you extracted the installation package:

EX Administrator: Windows PowerShell ISE
File Edit View Tools Debug Add-ons Help

O x| 9 B |8 0o @,

PSs C:\> cd "C:\TestDeploy

3. Type \install.ps1 for either install or upgrade.

Administrator: Windows PowerShell ISE
File Edit View Tools Debug Add-ons Help

g » | 9 GILI-&::'E‘"E'—E¢

Ps C:\> cd "C:\TestDeploy\collab_11.1.0.20230223113711"

P5 C:\TestDeploy\collab_11.1.0.20230223113711> .\install.ps]|

4. Iftheinputs.jsonfile is in same location as the extracted installation files, simply click enter
to execute the installation. Alternatively, if you have file in different location provide this
file location, then execute the script.



7 Sync Service [PAL)

This section provides instructions to configure the ATIPXpress Sync Service (PAL) and

permissions. This section is relevant only if PAL is installed on your Web server.

7.1 Public Module Database Server and Database

Information

(') Notes:

Prior to configuring ATIPXpress Sync Service, ensure that the PAL Database has been
created.

The Download Document location is with respect to the ATIPXpress Sync Service only if
you are using database configuration for your Sync Service. The configured user of the
ATIPXpress Sync Service should have Full Control Security permissions on the Download
Document location.

The Download Document folder should be manually created on the local or remote
system. Ensure that the ATIPXpress PAL application and the Download Document folder
path (local or UNC) is accessible by the IIS user on the system where the ATIPXpress PAL
applicationis installed. The path for the Download Document folder should be accessible
by creating the virtual directory (DOWNLOADDOCUMENTS) on the ATIPXpress PAL
application server.

The Electronic Reading Room folder should be manually created on the local or remote
system. Ensure that before the IS user accesses the ATIPXpress PAL application, the
Electronic Reading Room folder path (local or UNC) is accessible to the system on which
the ATIPXpress PAL application is installed. The path for the Electronic Reading Room
folder should be accessible by creating the virtual directory
(ELECTRONICREADINGROOMDOCUMENTS) on the ATIPXpress PAL application server.

To configure ATIPXpress Sync Service, perform the following steps:

1. Select Start > All Programs > AINS ATIPXpress.
2. Right-click ATIPXpress Sync Configuration and select Run as administrator.
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E' Database Configuration

B Diagnostic Tool

.’r FOIAXpress Configuration

s
FOIAXpress S Pin to Start

Pin to taskbar
PNG Cache Tt Uninstall
Open new window
'5' Run as administrator
Run as different user

Open file location

3. The Sync Service Configuration window will appear with the fields described in the table
below based on the database server type (MS SQL Server) you configured earlier. Enter the
required information and click Configure. The screen below uses MS SQL Server.

B ATIPXpress Sync. Service Configuration [= o T

] ™% Enter the database server information to create the configuration fle for the ATIPXpress
= Sync. Senice apphication

Database Server Informaton
Connect PAL Using WebService

Pubic Acc Link Database Server
e : Dashboard

S 1% & Carver
Server Type: | MS SOL Serves v Sync. interval (Minutes)

Publc Access Link Database information
Auto Merge Requester Profie
Server Name:

Database Name [ When Reguester Address s Updated, Update
Vindows Authentcaton Requests | Nose v
Logh D 2 Addressas ‘1.'.:~-e v
Password

SMTP Server nformation

SNTP Secver SMTP Port Number
Reprocess Faled Jobs for every V1 Send E-mal Adert for every Hour(s)
Sync. Service Inferval (Mnutes) | & Contact £.mat

Download Documents Location
PAL Reading Room Locaten

The Download Document location Is with respect to the ATIPXpress Sync. Service. The configured

user for this senice should have Full Permissions on the above speced download document location
Before accessing ATIPXoress Pudlic A Link, make sure that he same location is accessidle to e
system where ATIPXpress Public Access Link is Installed and # is configured in the Modules section of
ATIPXpress Public Access Link conigurasion URL

Public Access Link Faded Reguesters

ublic Access Link Falled Requests

Note: Please restan the ATIPXpress Scheduler Senvice for the configuradion changes 1o be effected
Logped-in user must have full control on '‘Conlig ini' file located in
CProgram Files (BENINS ATIPXpress\Schodulenbin
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Server Type

Server Name

Database Name

LoginID

Password

Dashboard

Auto Merge Requester
Profile

When Requester
Address is Updated,
Updated

SMTP Server

SMTP Server Port No.

MS SQL Server.

The title given to the server where the PAL database resides.

The title given to the PAL database during creation.

The unique identifier of the database owner (for example,
ATIPAgent).

The password associated with the database owner ID.

When selected, allows you to set the sync interval in number of
minutes.

When selected, automatically merges a requester’s ATIPXpress
profile data with a newly created requester’s profile in PAL.

Determines whether to update the requester’s address in PAL if
it is modified in the ATIPXpress application. The system will
update the address for Open, Closed, Open and Closed, or None
of the requests. If the Billing/Shipping address is modified in the
ATIPXpress application, the system will update the Billing,
Shipping, Billing and Shipping or None of the addresses in PAL.

The title given to the SMTP server.

The number assigned to the SMTP Server port. By default, the
port number is 25.
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Reprocess Failed jobs How often and at what interval failed jobs will be reprocessed.

for every The field specifies a unit of time and frequency (how often the
reprocess has to be invoked). If the process fails, it automatically
is reprocessed.

Send E-mail Alert for A time interval to send an email alert for failed jobs.

every

Sync Service Interval The time gap after which the synchronization process starts again
(Mins.) and will process all jobs within the queue. Effectively, this is the

sleep time between which the synchronization service stops and
resumes another cycle of the sync process. When the sync
process starts, the ATIPXpress PAL database is updated with the
latest requesters and request information.

If the sync process interval time is more than the number of jobs
to be processed in a synchronization process, the cycle will also
increase, and vice versa. The sync service must be set to anumber
greater than zero.

Contact Email The electronic mail address where failed job notifications will be
sent.

Download Document This location stores the requested documents where the

Location requested delivery mode is ‘PAL.' This location mustbe ona
remote system that is accessible to the ATIPXpress Sync Service.
(For example: \\systemname\foldername)

The Download Document Folder must be shared prior to
installing the sync service so it is available for selection during the
configuration process.



PAL Reading Room

Location

Sync Service (PAL)

This location stores the electronic reading room documents and

must be on a remote system, which is accessible to the

ATIPXpress Sync Service.

7.2 Using the WebService to Connect to PAL

Using the WebService to connect to PAL does not require database access. However, you must
configure the WebService in |IS to have a successful connection.

(') Note: The below steps should be taken on the server where PAL is configured.

1. Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2. Expand Start Page > Sites > PALConfig and select the WebServices folder.
3. Double-click Authentication in the middle pane and enable Windows Authentication.

B

m |0 » TW-SANDBOX » Sites » PALConfig »

File View Help

@ - &

e Q_ﬂ Start Page
.93 TW-SANDBOX (TW-SANDEO
..... Q Application Pools
4.8 Sites
b €D Default Web Site
b €D PAL

1 4D PALConfig

0 Authentication

Group by: Mo Grouping

MName -

Anonymous Authentication
ASP.NET Impersonation
Basic Authentication

Forms Authentication

Status

Enabled
Disabled
Disabled
Disabled

Response Type

HTTP 401 Challenge
HTTP 302 Login/Redirect

: Windows Authentication

Enabled

HTTP 401 Challenge i

4. Click the WebServices folder on the Connections pane to return to the WebServices

Home screen.

5. Right-click the PALConfig node and select Edit Bindings.
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Crnempression

. 4D Default Web Site ~2
& paL )
v &8 PALConfin Arsthantic
, .[7] App| ) Explore
1 bin Edit Permissions...
» o[ imag o, -
[ Instr] = Add Application...
. B Layo| & Add Virtual Directory...
> 1 Loca Edit Bindings...
< Mam
y | Mess Manage Website 3
.
it PRCg Refresh
-_| Relez
Lo Weh! Remowve
Rename

Switch to Content View

6. Addthe HTTP Secure Socket Layer port assignment. Click Add. The Add Site Binding

window appears.

Sync Service (PAL)

Det

Docu

Add Site Binding
Type

|| http Type: IP address: Port:

https | (e | [All Unassigned BIE

Host name:

Example: www.contosa.com or marketing.contose.com

Cancel

Clos:

a. Select https from the Type dropdown menu.
b. Select the SSL Certificate provided in the drop-down list. For example, WMSvc-TW-

AINSDOCSAX.
Add Site Binding ?
Type: IP address: Port:
https ~ | |All Unassigned v| ‘443 ‘
Host name:
| |
[ Require Server Name Indication
SSL certificate:
OK Cancel

c. Click OK to retain the settings or click Cancel to exit from the Site Bindings window.

7. Addthe SSL Certificate. If a certificate is not available in the SSL Certificate drop-down

list:

a. Select the Start Page (name of the server).

b. Click the Server Certificates option in the middle pane.
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Filter:

Go - \s7Show All | Group by: Area
19

L 9 e 2 2

Authentic.. Compression  Default Directory  Error Pages Handler

Document  Browsing Mappings

o
Feature

Shared
Delegation Configurat...

& §

HTTP
Respon...

= SO =

=

Logging  MIME Types  Modules Output

Caching

Request
Filtering

Management

B

Configurat...
Editor

£
& &y
Server Werker
Jetdisatey Processes

c. Click Create Certificate Request in the Actions pane. For further instructions, go to

http://technet.microsoft.com/en-us/library/cc732906.aspx.

d. Click Complete Certificate Request in the Actions pane. For further instructions, go

to http://technet.microsoft.com/en-us/library/cc771816.aspx.
8. Configure SSL Settings:
a. Double-click SSL Settings.
b. Select the Require SSL checkbox.
c. Accept client certificates.
d. Click Apply in the Actions pane.

9. Click the PALConfig node in the Connections pane to return to the home page.
10. Click the Connect PAL Using WebService option on the ATIPXpress Sync Service

Configuration window.

(') Note: This should be done on the server where the ATIPXpress Sync Service is installed.

11. Provide the PAL WebService URL in the URL field. For example:
https://palserver/webservices/syncservice.svc.

(') Note: The palserver portion of the URL above needs to reflect your PAL server name.

12. Enter the Windows Login ID and Password for the PAL Server.
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by ATIPXpress Sync. Service Configuration — X
(] ™% Enter the database server information to create the configuration file for the ATIPXpress
= Sync. Senvice application.
L - —
Database Server Information
Connect PAL Using WebService

WebService Configuration [/]Dashboard

Sync. Interval (Minutes). | 1440

Login l:l |:| Auto Merge Requester Profile
Password: I:I When Requester Address is Updated, Update

Requests | Both Open/Closed ~

Test Connection Addresses

SMTP Server Information

SMTP Server: [192.168.1.114 SMTP Port Number

Reprocess Failed Jobs for every Hour(s). Send E-mail Alert for every Hour(s).

Sync. Service Interval (Minutes): l:l Contact E-mail: |jmuyer@ains.cum |

ATIP¥press Failed Requesters (0) Public Access Link Failed Requesters (0)
ATIP¥press Failed Requests (0) Public Access Link Failed Requests ()
MNote: Please restart the ATIPXpress Scheduler Service for the configuration changes to be effected

Logged-in user must have full contral on ‘Config.ini’ file located in
"CAProgram Files (x86NAINS ATIPXpress\Schedulenbin®.

13. Enter the required information, and click Configure.
14. A confirmation message appears once the information is accepted. Click OK.

7.3 ATIPXpress Failed Requests and Requesters

Within the ATIPXpress Sync. Service Configuration window, you can view the number of
ATIPXpress failed requests and requesters, and Public Access Link failed requests and
requesters. Based on this information, you can take an appropriate action, such as retrying
failed jobs. These fields are represented as links that will be enabled only when there are failed
requesters and/or requests of ATIPXpress and/or PAL respectively. You must click the links on
the bottom-left of the ATIPXpress Sync Service Configuration window in order to view the
failed jobs.

FOl&presz Failed Requesters Public ccess Link Failed Requesters
FOl&press Failed Fequests Fublic ccess Link Failed Fequests
Mote: Please restart the FOlAXpress Scheduler Service for the configuration changes to be effected

Logged-in user must have full contral on 'Canfig.ini* file located in
‘CAProgram Files @8ENAINS FOlAXpressiSchedulertbin'.

Configure Assignments | Configure I Cancel




Sync Service (PAL)

1. After clicking the ATIPXpress Failed Requesters/Requests link the ATIPXpress Failed
Requests window appears.

Xpress Falled Requesters (0) Public Access Link Falled Requesters (0)

ATIP
ATIPXpress Failed Requests (0 Public Access Link Falled Requests (0)

Note: Please restart the ATIPXpress Scheduler Senice for the configuration changes to be effected
Logged-in user must have full control on 'Config.ini’ file located in
‘CAProgram Files (x86\AINS ATIPXpress\Schedulenbin’

| Corfigue | | Cancel

2. Toretry the failed requests/requesters, select the checkbox for each job and click Retry.
('') Note: All failed jobs will be sent to the sync service.

3. Toview the details of the failed jobs, select a job and click View or double-click the selected
job.
Failed Job Description -

Close

FOl|AX¥press Failed Request Details

Request ID | |

Requester Name |K|1.|singer. Rebecca |

Emor Description Emor From WCF : ProcessFXTransactions
:System . Exception: Incomect syntax near the
keyword ‘group”.
Unclosed quotation mark after the character
string ).

at SyncService. ProcessFXTransactions
(String strinvoices¥ml, String
strinvoiceDetailsXml, Stri

Visble Request D |2017-FOI0D053-BK '

4. Toexportfailedjobs to alogfile, click Export Failed Jobs to Log.
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Fde Edt Format View Help
h57 2017-FOI-00053-BK Krusinger, Rebecca Error From WCF : ProcessFXTransactions :System.Exception: -~
Unclosed quotation mark after the character string )",

at SyncService,ProcessFXTransactions(String strlnvoicesXal, String strlnvoiceDetailsXal, Stri
279 2018-VPRT-YA AD- AO-AY-00002 Yerramaneni, Akhila Error From WCF : ProcessFXTransactions ;System.Exc

Unclosed quotation mark after the character string °)". =
at SyncService.ProcessFXTransactions(String strinvoicesXal, String strlnvoiceDetailsXaml, Stri
508 2017-APP-MARAD OC-DM-00@64 Kyle, Mills Error From WCF : ProcessFXTransactions :System.Exception:

Unclosed quotation mark after the character string °)°.

at SyncService.ProcessFXTransactions(String strinvoicesXal, String strinvoiceDetailsXml, Stri
546 KN-AQ-AI-17-00011 Beherendorff, Jason Error From WCF : ProcessFXTransactions :System,Exception:
Unclosed quotation mark after the character string *)°.

at SyncService.ProcessFXTransactions(String strinvoicesXml, String strlnvoiceDetailsXaml, Stri
549 2017-F0I-90212- Beherendorff, Jason Error From WCF : ProcessFXTransactions :System.Exception: Incorrec
Unclosed quotation mark after the character string °)".

at SyncService.ProcessFXTransactions(String strinvoicesXml, String strlnvoiceDetailsXaml, Stri
551 2017-APP-YA AD- AD-AY-00067 Yerramaneni, Akhila Error From WCF ; ProcessFXTransactions :System.Exc:
Unclosed quotation mark after the character string *)°.

at SyncService.ProcessFXTransactions(String strinvoicesXml, String strlnvoiceDetailsXml, Stri
564 KN-AQ-AI-17-00812 Beherendorff, Jason Error From WCF : ProcessFXTransactions :System.Exception:
Unclosed quotation mark after the character string °)°.

at SyncService.ProcessFXTransactions(String strinvoicesXml, String strlnvoiceDetailsXml, Stri
609 2017-FOI-909243-RA Norton, Bess Error From WCF : ProcessFXTransactions :System.Exception: Incorrec
Unclosed quotation mark after the character string *)°.

at SyncService.ProcessFXTransactions(String strinvoicesXal, String strlnvoiceDetailsXal, Stri
618 2017-Foip-test -Am Beth, laura Error From WCF : ProcessFXTransactions :System.Exception: Incorrec
Unclosed quotation mark after the character string °)".

at SyncService.ProcessFXTransactions(String strinvoicesXml, String strInvoiceDetailsXml, Stri
619 2017-FOI-00247-AM Beth, laura Error From WCF : ProcessFXTransactions :System.Exception: Incorrec
Unclosed quotation mark after the character string ")".

at SyncService.ProcessFXTransactions(String strinvoicesXsl, String strlnvoiceDetailsXml, Stri
621 2017-APP-HQ Testing-AM-29100 Beth, laura Error From WCF : ProcessFXTransactions :System.Exception:
Unclosed quotation mark after the character string *)'.

at SyncService.ProcessFXTransactions(String strlnvoicesXml, String strlnvoiceDetailsXal, Stri

623 Test12345 Watson, Sophia Error From WCF : ProcessFXTransactions :System.Exception: Incorrect syntax
Unclosed quotation mark after the character string *)". =
<| - >

7.4 Public Access Link Failed Requests and
Requesters

You must click the links on the bottom-right of the ATIPXpress Sync Service Configuration

window to view the failed jobs.

(') Note: The below screenshots show the Public Access Link Failed Requests screens,
however, the Public Access Link Failed Requesters screens look very similar.

1. After clicking the Public Access Link Failed Requesters/Requests link, the Public Access
Link Failed Requests window appears.

Retry  Select Al Deselect Al View  Export Failed Jobsto Log Close

ID Reguest D Requester Name Emar Description
[ 381 m, Samy Unable to create an appeal for TE...

Digplays the list of Public Access Link failed Requests and take the necessary action such az Retry forthe failed Regquests.
All the Retry Requests will be sent for Sync process again

2. Toretry the failed requests/requesters, select the checkbox for each job and click Retry.
All failed jobs will be sent to the sync service.

3. Toview the details of the failed jobs, select an ID and click View or double-click the
selected job.
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Close

Public: Access Link Failed Reguest Details

Request ID 361

Reguester Mame |m, Samy

Emor Description Unable to create an appeal for TBD in
secured subnet, as the request does not exist

Visible Request |0

4. Toexport failed jobs to the log file, click Export Failed Jobs to Log.
e L S |

Fe Eda Format View Help
pe1 m, Samy Unable to create an appeal for ‘TBD' in secured subnet, as the request does not exist
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8 Required Privileges for ATIPXpress PAL
Application Server

The following section lists the directories that are relevant to ATIPXpress PAL as well as the

level of permissions that should be applied to these directories.

8.1 Required Permissions for Network Service User
[ASP.NET Process Identity]

On aWeb server running Microsoft Windows Server 2016/2019/2022 and Internet
Information Services (I1S) 7.5/8/10, the ASP.NET process runs in the application pool for the
Web application. ATIPXpress PAL setup will set the application pool identity as NETWORK

SERVICE account by default.

The file and folder permissions listed in table below must have the ASP.NET Process Identity of
ATIPXpress PAL Web application (Network Service User/configured impersonate user).

%SystemRoot%\Microsoft.
NET\

Framework\versionNumber

\
Temporary ASP.NET Files

%SystemRoot%\assembly

%SystemRoot%\System32

Read, List Folder Contents,
Read & Execute, Write

Read, List Folder Contents,
Read & Execute

Read, List Folder Contents,
Read & Execute

This is the location for
dynamically compiled files.
Beneath this location,
application code generation
takes place in adiscrete
directory for each
application.

This is the location of the
global assembly cache
(GACQ).

This location contains
system DLLs loaded by .NET
Framework.
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%SystemRoot%\Temp

User profile directory

Electronic Reading Room
Documents Location

Download Documents
Location

Inetpub\wwwroot\

PublicAccessLink\PAL\imag
es

Inetpub\wwwroot\
PublicAccessLink\PALConfi
g\

images

Full Control

Read, List Folder Contents,
Read & Execute, Write

Read, List Folder Contents,
Read & Execute, Write

Read, List Folder Contents,
Read & Execute, Write

Modify, Read & Execute, List
Folder Contents, Read,
Write

Modify, Read & Execute, List
Folder Contents, Read,
Write
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This location is used for Web
services support.

This directory is used by the
GAC cache lock files and the
security configuration
caching mechanism of the
common language runtime.
If the user profile directory
for the account does not
exist, ASP.NET uses the
default user profile
directory.

All ATIPXpress PAL
electronic reading room
documents are stored in this
location.

All ATIPXpress PAL
download documents are
stored in this location.

This location stores the
images of the PAL website.

This location stores the
images of PAL Config
website.
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Inetpub\wwwroot\
PublicAccessLink\
PALConfig\App_Data

Program
Files\PAL\pallog.txt

-OR-
Program Files
(x86)\PAL\pallog.txt

Program
Files\PAL\Errorlog.txt

-OR-
Program Files (x86)\
PAL\Errorlog.txt

Modify, Read, & Execute,
List Folder Contents, Read,
Write

Modify, Read & Execute, List
Folder Contents, Read,
Write

Modify, Read & Execute, List
Folder Contents, Read,
Write

This location contains
dictionary file information

This file records the error
log information for PAL.

This file records the error
log information for
PortalXpress

(') Note: If file repository folders (Download Documents and Electronic Reading Room

document locations) are located on another server other than the ATIPXpress PAL

application server, set the required security and sharing permissions for the ATIPXpress PAL

application server account (network service user). Example: palserver$.
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|G&nera|| Sharing |Sec:Jrrty| Previous Versions | Customize

Metwork File and Folder Sharing
PAL
l . Shared
Metworle Path:
“WWa-sandboxpal

Advanced Sharing

Set custom pemissions, create multiple shares, and =et other
advanced sharing options.

| ) Advanced Sharing...

Close || Cancel || Apply

General ISharing Security |F‘rev1'ou5 Versions | Customize

Chject name:  C:MPAL

GI‘OIJD ar user names:

~
2 5YSTEM

% NETWORK SERVICE

£

To change pemissions, click Edit.

Pemissions for Everyone

Full control

Modify

Read & execute
List folder contents
Read

Write

For special permissions or advanced settings,
click Advanced.

The File Repository folder located on the file server should have the Read and Write
permissions for File Sharing and Full control for Security permissions. Please refer to the above
screenshots to view the permissions.
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8.2 ATIPXpress Sync Service Required Privileges

The following table shows which type of file and folder permissions the user must have to
function properly.

Location Access Account | Comments

Type

%SystemRoot%\assembly Read, List  Service This is the location of the global
Folder User assembly cache (GAC).
Contents,
Read &
Execute

%SystemRoot%\System32 Read, List  Service This location contains system
Folder User DLLs loaded by the .NET
Contents, Framework.
Read &
Execute

User profile directory Read, List  Service This location stores the cache
Folder User files of the Sync Service.
Contents,
Read &
Execute,
Write

%SystemRoot%\Microsoft. NET = Read, List Service  ASP.NET must be able to access

\Framework\version and Folder User the system assemblies
subdirectories Contents, referenced in the
Read & Machine.config file in the
Execute CONFIG subdirectory under

%SystemRoot%\Microsoft. NET\
Framework\version.
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Location Access Account | Comments
Type

AFXWDOFL Read & Service All ATIPXpress original
Execute, User documents are stored in this
List location.
Folder
Contents
and Read

AFXWERR Full Service All ATIPXpress electronic
Control User reading room documents are

stored in this location.

Program Files\AINS\\ Full Service Installed application files will be
ATIPXpress\bin Control User stored in this location.
-OR-

Program Files (x86)\AINS
\ATIPXpress\bin

Program Files\AINS\\Logs Modify, Service  The application error log and
-OR- Read & User configuration files will be stored
Program Files (x86)\AINS Execute, in this folder
\Logs Read,

Write
Documents Download Full Service This is provided in the Sync
Location Control User Service configuration. If request

delivery mode is set to web
download, the documents will be
stored in this location.
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Location Access Account | Comments
Type

Electronic Reading Room Full Service This is provided in the Sync

location Control User Service configuration. The
documents published from
ATIPXpress will be stored in this
location.

(') Notes:

= The above specified Download Document Location and Electronic Reading Room
Location should be the same as the location specified in the ATIPXpress Sync Service
Configuration.

= Thefolders \AFXWDOFL and \AFXWERR are the ATIPXpress File Repository folders.

= Thefolder %SystemRoot% is the Microsoft Windows installation folder.
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